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1 Release Information 

1.1 General 

Release Name 

The release name is RobotStudio 6.01 SP1 and the build number is 6.01.6426.0123. 

Release Date 

The release date is May 8th, 2015. 

Demo stations 

The following demo stations are included in this version.  

 Demo AW Station 

 Demo Solar Simulation 

 Demo Exhaust Pipe 

 Demo FlexLoader 

They are stored in the Pack & Go format (.rspag) and can be opened with the command 
Unpack & Work on the Share section of the RobotStudio menu. 

ScreenMaker Demo Station and Project 

There is a demo station and associated ScreenMaker project available. 

 SCM_ExampleProject (ScreenMaker Project) 

 SCM_ExampleStation (RobotStudio station) 

These files are found in the ‘Addins/ScreenMaker/Samples’ folder under the  RobotStudio 
installation folder .  

Tutorials 

Tutorials are available at the RobotStudio product pages at 
http://www.abb.com/roboticssoftware 

Documentation 

User documentation for RobotStudio is available from the Help button ( ) in the upper-
right corner of RobotStudio.  

The complete documentation in PDF for RobotWare including RobotStudio is available on 
DVD and can be ordered separately from ABB. 

1.2 System recommendation 

Recommended Software  

Operating System  

Microsoft Windows 7 SP1 32-bit edition 

Microsoft Windows 7 SP1 (recommended) 64-bit edition 

Microsoft Windows 8.1 (recommended) 64-bit edition 

 

 

http://www.abb.com/roboticssoftware
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Recommended hardware 

Item Requirement 

CPU 2.0 GHz or faster processor, multiple cores recommended 

Memory 3 GB if running Windows 32-bit  
8 GB or more if running Windows 64-bit (recommended) 

Disk 10+ GB free space, solid state drive (SSD) 

Graphics card High-performance, DirectX 11 compatible, gaming graphics card from 
any of the leading vendors. For the Advanced lightning mode Direct3D 
feature level 10_1 or higher is required. 

Screen resolution 1920 x 1080 pixels or higher is recommended 

DPI Normal size (100% / 96 dpi) up to Large size (150% / 144 dpi) 

Only Normal size supported for Integrated Vision. 

Mouse Three-button mouse 

3D Mouse [optional] Any 3D mouse from 3DConnexion, see http://www.3dconnexion.com. 

  

    Note 
 
The Windows Firewall will try to block features necessary to run RobotStudio. Make sure 
to unblock these features when asked (Industrial Robot Discovery Server, RobotStudio 
StudioAppFramework module, Virtual RobotController (all published by ABB)). The 
blocking state of a certain program can be viewed and changed at Start/Control 
Panel/Windows Security Center/Windows Firewall. Read more on 
http://www.microsoft.com. 

 
 

http://www.3dconnexion.com./
http://www.microsoft.com/
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1.3 Simulation Models 

Robot Libraries  

IRB Variant  IRB Variant  IRB Variant 

120 3kg/0.58m  360 3kg/1130 Stainless  6660 130kg/3.1m 

120T 3kg/0.58m  360 1kg/1600 Standard  6660 205kg/1.9m 

1200 5kg/0.9m BTM  360 6kg/1600 Standard  6700 145 kg/3.2m MH 

1200 5kg/0.9m STD  360 8kg/1130 Standard  6700 145 kg/3.2m SW 

1200 7kg/0.7m BTM  4400 45kg  6700 150 kg/3.2m MH3 

1200 7kg/0.7m STD  4400 60kg  6700 150 kg/3.2m 

140 5kg/0.8m Type A/B  4400L 10kg  6700 155 kg/3.05m MH 

140 5kg/0.8m Type C   4400L 30kg  6700 155 kg/3.05m SW 

140 6kg/0.8m Type C  4400S 30kg  6700 175 kg/3.05m MH3 

140T 5kg/0.8m Type C  4450S 30kg  6700 175 kg/3.05m 

1400 Type A/B  4600 20kg/2.5m  6700 200 kg/2.8m MH 

1400H Type A/B  4600 20kg/2.5m Type C  6700 200 kg/2.8m SW 

1410  4600 45kg/2.05m Type C  6700 205 kg/2.8m MH3 

1520ID  4600 60kg/2.05m  6700 205 kg/2.8m 

1600 5kg/1.2m  4600 60kg/2.05m Type C  6700 140 kg/2.85m MH 

1600 5kg/1.2m Type A  460  6700 140 kg/2.85m SW 

1600 5kg/1.45m  4600 40kg/2.55m  6700 155 kg/2.85m MH3 

1600 5kg/1.45m Type A  4600 40kg/2.55m Type C  6700 155 kg/2.85m 

1600 6kg/1.2m  4600 45kg/2.05m  6700 220 kg/2.65m MH 

1600 6kg/1.45m  6400R 200kg/2.5m  6700 220 kg/2.65m SW 

1600 7kg/1.2m  6400R 200kg/2.8m  6700 235 kg/2.65m MH3 

1600 7kg/1.2m Type A  6400R 120kg/2.5m  6700 235 kg/2.65m 

1600 7kg/1.45m  6400R 150kg/2.8m  6700 175 kg/2.6m MH 

1600 7kg/1.45m Type A  6400R 150kg/2.8m  6700 175 kg/2.6m SW 

1600 8kg/1.2m  6400R 100kg/3.0m  6700 200 kg/2.6m MH3 

1600 8kg/1.45m  640  6700 200 kg/2.6m 

1600 10kg/1.2m  660 180kg/3.15m  6700 220kg/3.0m MH 

1600 10kg/1.45m  660 250kg/3.15m  6700 220kg/3.0m SW 

1600ID 4kg/1.5m  6600 175kg/2.55m  6700 245kg/3.0m MH3 

2400 10kg  6600 175kg/2.80m  6700 245kg/3.0m  

2400 16kg  6600 225kg/2.55m  6700 270kg/2.7m MH 

2400L   6600ID 185kg/2.55m  6700 270kg/2.7m SW 

2600 12kg/1.65m  6620 150kg/2.2m  6700 300kg/2.7m MH3 

2600 20kg/1.65m  6620LX-150/1.9m  6700 300kg/2.7m  

2600 12kg/1.85m  6640 130kg/3.2m  7600 150kg/3.5m 

2600ID 8kg/2.0m  6640 180kg/2.55m  7600 325kg/3.1m 

2600ID 15kg/1.85m  6640 185kg/2.8m  7600 340kg/2.8m 

260  6640 205kg/2.75m  7600 400kg/2.55m 

340  6640 235kg/2.55m  7600 500kg/2.3m 

360 1kg/1130 Std No axis 4  6640ID 170kg/2.75m  7600 500kg/2.55m 

360 1kg/1130 Wash-down No axis 4  6640ID 200kg/2.55m  760 

360 1kg/1130 Standard  6640 150kg/2.55m DP6   *8700 475kg/4.2m MH6 

360 1kg/1130 Wash-down  6640 165kg/2.8m DP6   *8700 475kg/4.2m SW6 

360 1kg/1130 Stainless  6640 185kg/2.75m DP6   *8700 550kg/4.2m MH3 

360 1kg/800 Std No axis 4  6640 200kg/2.55m DP6   *8700 550kg/4.2m 

360 1kg/800 Wash-down No axis 4  6650 125kg/3.2m   *8700 630kg/3.5m MH6 

360 1kg/800 Std  6650 200kg/2.75m   *8700 630kg/3.5m SW6 

360 1kg/800Wash-down  6650ID 170kg/2.75m   *8700 800kg/3.5m MH3 

360 3kg/1130 Std No axis 4  6650S 125kg/3.5m   *8700 800kg/3.5m 

360 3kg/1130 Wash-down No axis 4  6650S 200kg/3.0m  **940 

360 3kg/1130 Standard  6650S 90kg/3.9m  *14000 

360 3kg/1130 Wash-down  6600 100kg/3.35m   

 
** requires the StandAlone Controller mediapool that is available for download from Add-Ins tab / RobotApps / RobotWare Add-Ins 

 

    Note 
 
All simulation models in the table are installed with RobotStudio, but only the robots in 
the current product range are displayed in the ABB Library gallery. To import any other 
robot you need to browse to the file on disk. 
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Robot Libraries Paint 

Variant 

52 short vertical arm 

52 std vertical arm 

540-12 std arm 

580-12 std arm 

580-12 short arm 

5300-12 left 

5300-12 right 

5320-1500 

5320-2000 

5350/01 Type Left  

5350/01 Type Right  

5350/02 Type Left Side Left 

5350/02 Type Left Side Right 

5350/02 Type Right Side Left 

5350/02 Type Right Side Right 

5400-12 std arm 

5400-13 std arm 

5400-14 std arm 

5400-22 process arm 

5400-23 process arm 

5400-24 process arm 

5400-12 std arm axis 2 +60 deg 

5400-13 std arm axis 2 +60 deg  

5400-14 std arm axis 2 +60 deg 

5500 35A b_00 / b_80 

5500 35B b_00 / b_80 

5500 ProArm 35A b_00 / b_80 

5500 ProArm 35B b_00 / b_80 

Track Libraries 

RobotStudio is distributed with the following track types that are available in the Track folder 
of the ABB Library. 

Track family Length 

IRBT4003 1.7 m to 10.7 m 

IRBT4004 1.9 m to 19.9 m 

IRBT6003 1.7 m to 10.7 m 

IRBT6004 1.7 m to 19.7 m 

IRBT7003 1.7 m to 10.7 m 

IRBT7004 1.7 m to 19.7 m 

RTT_Bobin 1.7 m to 11.7 m 

RTT_Marathon  1.7 m to 11.7 m 

Paint Rails 
  left and right versions 

2 m to 20 m 

IRB5350 Rail 

  left and right versions 

3 m to 10 m 
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2 What’s new in RobotStudio 6.01 

Overview 

The new functionality of RobotStudio 6.01 is described in this section. 

2.1 New robot models 

IRB 14000 

The new dual arm robot is available in RobotStudio. You can use it with the Smart Grippers 
that are available from the ‘Import Library’ gallery.  

 

IRBT 8700 

The heavy duty robot IRB 8700 is now available in RobotStudio. It comes in two sizes of 
which the strongest can take up to 800 kg payload. The IRB 8700 is available with the 
LeanID wrist in addition to the regular wrist. You can get it pre-dressed for spot welding or 
material handling. 

 

IRBT 4004 / 6004 / 7004 

The IRBT x004 series of track motions has been available since long in RobotStudio. The 
new thing in 6.01 is that the mirrored and double carriage variants are also available. The 
double carriage variant is modeled as two individual models that needs to imported and 
configured separately. 
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2.2 General 

Disable licensing 

If you are using a network license, you can use RobotStudio in Basic mode without grabbing 
a license from the license server if you select the check box ‘Disable licensing’ in the  
RobotStudio Options. 

 

Keyboard shortcuts for navigation in the 3D graphics view 

The arrow keys can be used to rotate the 3D view. If you press and hold the Ctrl button you 
can pan the view with the arrow keys. You can zoom by the pressing the PageUp and 
PageDown buttons. The navigation keys work also for station viewers as well as the ‘Online 
Monitor’. 

 

2.3 Layout and Modeling 

3D Work Envelope 

A 3D volume representing the work envelope of the arobot can be enabled by selecting the 
‘Work envelope’ option of the context menu of a robot. You can select choose between 
using the wrist center point or the active tool center point to define the work envelope. 
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Remove internal geometry 

Hidden bodies, faces and triangles can be automatically removed by the function ‘Remove 
internal geometry’. The function aims to simplify the process of removing excess detail of 
CAD parts. 

 

Snap to center of hole 

If you click on a surface close to a circular edge with ‘Snap Mode: Center’ enabled, 
RobotStudio will snap to the center of the circular edge. This is useful if you want to pick the 
center point of a hole. 

 

VRML export 

Parts and stations can be exported to the VRML2 format using the ‘Export Geometry’ 
function. 
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Shallow rectangle selection 

By pressing and holding the Shift keyboard button you can draw a selection rectangle with 
the mouse cursor in the 3D view. Starting with RobotStudio 6.01, you can optionally select 
only the currently visible objects using rectangle selection. This selection mode is called 
‘shallow rectangle selection’ and is enabled if you press and hold the keyboard buttons Shift 
and S and draw a rectangle in the 3D view using the mouse. The default selection mode is 
still the usual ‘deep rectangle selection’ that selects everything covered by the selection 
rectangle regardless of its visibility. 

 

Four bar linkage 

Four bar linkages are typically used for the hinges of motor hood. These can now be 
modeled in RobotStudio if you use an .rsxml file to describe your mechanism. The library 
can be built by importing the .rsxml file using the ‘Import Library’ command. 

 

 

Sample .rsxml file: 

<?xml version="1.0"?> 
<Mechanism xmlns="urn:abb-robotics-robotstudio-graphiccomponent" lengthUnit="mm" angleUnit="deg" name="Test" 
modelName="Test" type="Other"> 
  <Links baseLink="FourBarLink_Base"> 
    <Part name="FourBarLink_Base" source="FourBarLink_Base.sat" /> 
    <Part name="FourBarLink_Crank" source="FourBarLink_Crank.sat" /> 
    <Part name="FourBarLink_Lever" source="FourBarLink_Lever.sat" /> 
    <Part name="FourBarLink_Coupler" source="FourBarLink_Coupler.sat" /> 
  </Links> 
  <Joints> 

<!-- This is the new tag /> 
    <FourBarJoint name="J1" axis="0, -1, 0" parent="FourBarLink_Base" child="FourBarLink_Coupler">  
      <Crank link="FourBarLink_Crank" point1="1354.00 , 0 , 602.99" point2="1396.73,  -1,  683.64"/> 
      <Lever link="FourBarLink_Lever" point1="1215.17 , 0,  600.23" point2="1323.31,  -1,  682.53"/> 
    </FourBarJoint> 
  </Joints> 
  <Limits> 
    <Limit joint="J1" min="-90" max="90" /> 
  </Limits> 
</Mechanism> 
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Graphics Tools: Replace Material 

If you have a part with several different materials, i.e. colors, and you want to replace one of 
them, then you can use the function ‘Replace Material’. Select a material from the ‘Materials’ 
gallery and click on a surface of your to part to replace its material.  

 

Switch between Euler angles and Quaternions 

The representation of orientations can be switched between angles and quaternions. Which 
representation to use by default is defined by the RobotStudio Options. 

 

Show and Hide SetBrush instructions 

The visibility of SetBrush instructions can be changed through a context menu command. 
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2.4 Offline programming 

System From Layout: Align task frame with track base frame 

There is an option in the ‘System From Layout’ wizard to place the task frame by the robot 
base frame. In 6.01, the selection has been extended to also include the track base frame, if 
available.  

 

Visualization of programmed speed 

The programmed speed of a path can be visualized by the command ‘Show speed’ in the 
Path context menu.  

 

Set color of path 

The color of all motion instructions of path can be set by the function ‘Set Color’. Starting 
with 6.01, the function is also available on the Path level. The command will override any 
colors defined on the instructions. 
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External axis smoothing 

The movement of an linear or rotating external axis can be smoothened by the new option 
‘Constant speed’ that is available in the command ‘Interpolate External Axis’.  

 

Export station logic 

The Station logic used to define the behavior of the surrounding equipment and its 
connections to the virtual controller can be exported to a file for later re-use in another 
station. 

 

Station change log and version numbering 

Each time a station is saved using ‘Save As’, its filename is incremented and a change log 
comment optionally added. The change log will be displayed in the Info and Recent sections 
of the File tab. 
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Automatic backup on save of RobotStudio Solution  

The controllers of your station will be automatically backup when saving the station if your 
are using a solution. The backups can be used to manually restore the controller data. 

 

2.5 Online functions 

FlexPendant Viewer – Copy to Clipboard 

The new button ‘Copy to clipboard’ is useful e.g. when creating user documentation of 
FlexPendant user screens. 

 

HOME folder visible in Controller browser 

The content of the HOME folder of the connected virtual or real controller is visible in the 
Controller browser. Both RAPID and configuration files can be edited as text files. 

For virtual controllers, RAPID modules can be synchronized to the graphics environment of 
the station using the context menu of the RAPID module file. To synchronize any changes 
back to the RAPID module, use the command ‘Synchronize to file’. 
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I/O Signal Data Editor 

The signal instances of a EIO.CFG file can be edited with the ‘I/O Signal Data Editor’ 
available in the Files browser of the RAPID tab.  

 

Remove unused data in RAPID module 

To clean up a module, you can use the command ‘Remove unused data in Module’. The 
command will remove any RAPID data that is declared in the selected module, but neither 
used in the module nor in the current task. 

 

Display Euler angles in RAPID Data Editor 

By selecting the checkbox ‘Show quaternions as RPY angles’ in the RAPID Data Editor, the 
orientation of e.g. robtargets will be displayed in angles instead.  
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Local client 

RobotStudio can act as a local client thereby getting full access to the controller functionality 
without restrictions in manual mode. When you select the local client checkbox in the ‘Add 
Controller’ dialog or in the ‘Login’ dialog you can get local client privileges by pressing the 
enabling switch on the safety device twice. Examples of safety devices are the FlexPendant, 
the Jokab JSHD4, and the Keba T10. 

 

Low bandwidth mode 

The low bandwidth mode is useful when connecting RobotStudio to a controller over a 
network connection with limited bandwidth. It reduces controller communication to a fraction 
of the regular connection mode. 

 

New Job Actions 

There are new job actions for verifying time, saving or searching event logs, reading cfg 
data, signal values and RAPID data or text. You can also read or write files and get the 
system information for all controllers. Note that the Restart action has been removed. 
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Settings file for automatic selection of RobotWare options 

When migrating a RobotWare 5.60/5.61 key using a backup or a connected controller you 
will get a settings file (.rsf) in addition to the license file (.rlf). The settings file can be used by 
the Installation Manager to automatically select the options used by the original system. 

 

 

 
 
 
 



Release Notes 
                                                                                                                                RobotStudio 6.01 SP1 

 

© Copyright 2015 ABB All rights reserved  20 

  

3 Late Breaking Information 

Overview 

This section contains information about late changes that were done after the RobotStudio 
6.01 Operating Manual was finalized. The following new commands has been added but are 
not covered by the 6.01 Operating Manual 

 Remove internal geometry 

 VRML export 

 Shallow rectangle selection 

 Four bar linkage 

 Graphics Tools: Replace Material 

 Visualization of programmed speed 

 External axis smoothing 

 HOME folder visible in Controller browser 

 Display of Euler angles in RAPID Data Editor 

 New and removed Job Actions 

See section 2 for more information. 
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4 Corrections 

4.1 Corrections made in 6.01 SP1 

Overview 

This section describes the corrections made in 6.01 SP1. 

Corrections  

ID Title  

- 

The base Smart Component ‘LogicExpression’ failed 

A problem with the regular expression parser caused the smart component to fail. 

- 

The Jobs action ‘System Information’ failed 

The System Information action is new to 6.01 and unfortunately failed due to a late 
change. 

- 

Unhandled exception when library mechanism was selected for external axis 

The exception appeared, for example, when browsing to a mechanism library when 
configuring an external axis servo gun. 

- 

Unhandled exception when copying target to a new workobjekt 

When copying targets from one workobject to another by copy/paste or drag-and-drop 
an unhandled exception appeared. 

 

4.2 Corrections made in 6.01 

Overview 

This section describes the corrections made in 6.01. 

Product Defect Documents (PDD) 

ID Title  

36 RobotStudio cannot be closed while simulation is running 

45 Geometry import fails for curves in COLLADA format (.dae) 

1229 Not possible to save multiple RAPID modules in one operation 

1231 
File Transfer window does not allow drag-and-drop file within pane inside another 
folder 

1267 UAS Users window sometime abruptly minimizes 

1395 Virtual Controller connection may fail after crash of RobotStudio 

1590 Cosmetic errors in the I/O Simulator user interface 

1688 No switch to Controller tab when controller is connected from File tab 

1690 Focus removed from I/O Simulator when ‘Follow Program Pointer’ is active 

1757 
The I/O simulator does not show signals that are configured with a mix of upper and 
lower case letters in the Configuration database. 

1916 Add RobotStudio option for not grabbing a network license 

1943 Back-up folder looks like robot system folder in RobotStudio 

1955 UAS: Renamed Users group is not removed from Users list 

1982 RobotStudio does not open Controller tab when a controller is added from File tab 

2067 
Cannot make bodies permanently invisible, they become visible when re-loading 
station 

2087 Incorrect formatting of RAPID program with ERROR statement 

2104 Columns for Module in dialog for ‘Synchronize to RAPID’ are too narrow 

2136 Error in page numbers when printing RAPID module 
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2434 
‘AutoConfiguration’ fails for circular points when using stationary tool and moving 

workobject 

2557 Drag-and-drop errors in ‘File Transfer’ tool 

2652 Add option to show ‘All Tags’ in the ‘Show/Hide’ menu 

3109 
System From Layout: The pedestal weight is automatically added to the configuration 
parameters for IRBT x004 

3173 
The instance editor does now allow to change characters of the signal definition from 
upper case to lower case 

3190 Crash when importing a STEP file created with SolidWorks  

3344 Library for IRBT 4004 type A not correct – hole pattern missing on carriage 

3368 ‘System from Layout’ must be blocked for IRB on RTT with IRBP K (not enough drives) 

3406 
Changing language causes .rspag or .rsstn file to be re-opened if RobotStudio was 
started by double-clicking file in Windows Explorer. 

3875 Allow remote controller connection 

3904 French localization issues 

4115 Losing view center when rotating the view 

4156 Lack of error handling in Control Panel 

4173 The function ‘Migrate Backup or Folder’ is greyed out 

4236 Automatic transparency not documented in the Operating Manual 

4304 Copy / Paste of move instructions reverses order if pasted on other move instruction 

4358 Visual SafeMove fails to automatically generate zone from simulation 

4467 Memory issue when restoring backup on virtual controller 

4538 Direction control should not response to point picking 

4569 Saving a station viewer may cause libraries to be renamed and relocated 

4571 Poor performance with ‘System from Layout’ 

4572 Error message for ‘Upgrade Boot Application’ clarified if controller already upgraded 

4598 Library for IRBT 4004 type A not correct – hole pattern on carriage incorrect 

4602 RobotStudio fails when connected through Remote Access in Remote Service 

4616 Frequent RobotStudio crashes during Smart Component simulation 

4628 Installation issues causes CAD conversion to fail 

4633 RobotWare 6 appears as two different versions in Add-Ins browser. 

4634 RobotStudio Product Specification does not contain the option numbers 

4657 Conveyor tracking: Start window width cannot be set to non-zero for paint systems 

4673 CAD import fails due to faulty installation 

4697 Visual SafeMove incorrectly warns about difference between safety and controller 
configuration 

4764 Not possible to delete station tasks 

4732 Simulation hangs every second time 

4761 ‘Import Geometry’ fails due to problems with installation 

4777 Slow response for ‘View Robot at Target’ 

7514 Unit mapping missing in the ‘I/O System’ viewer 

8743 The function ‘Show Work Envelope’ ignores the x values of tooldata 

9844 Hint about possibly empty path added to function ‘Create Target on Edge’ 

10725 Cannot select range of instructions in ‘Interpolate External Axis’ 
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5 Known Limitations 

Overview 

This section describes known limitations in RobotStudio. 

5.1 General 

Compatibility of RobotStudio Library and Stations with older RobotStudio versions 

RobotStudio is generally not forwards compatible, i.e. it is not possible to load stations or 
libraries created in RobotStudio 6.01 into an earlier version of RobotStudio such as e.g. 
RobotStudio 5.15.02, 5.61.02, 6.0, 6.00.01 or earlier. However, RobotStudio is backwards 
compatible, which means stations and libraries created in versions 5.15.02, 5.61.02, 6.0, 
6.00.01 or earlier can be opened in RobotStudio 6.01. 

5.2 Online 

Visual SafeMove windows can be re-opened from the Quick Access Toolbar menu 

Any windows that are closed can be re-opened using the Quick Access Toolbar menu, as 
the command Default Layout does not recover these windows. 

Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later 

When running multitasking systems, it is not possible to start and stop individual tasks with 
the dropdown menu of the task node in the Controller browser. This is due a restriction 
introduced with RobotWare 5.60 and later. 

Signal Analyzer Online not available for RobotWare 5.60, RobotWare 5.15.02 and earlier 

The feature Signal Analyzer Online is not available for controllers running RobotWare 5.60, 
RobotWare 5.15.02 and earlier. The reason is a vulnerability in Robotware that may cause 
interruptions in the robot operation.  

Signal Analyzer Online is supported by Robotware 5.15.03 and later, and RobotWare 5.61 
and later, where the problem has been corrected. 

It is not recommended to use Signal Analyzer Online of RobotStudio 5.15.01 or 5.15.02 with 
RobotWare versions prior to 5.15.03 or 5.61. 

SafeMove Tool Zone visualization in Online Monitor for robots with external axes 

Only TCP robots and track mounted robots will be visualized in the Online Monitor, no other 
external axes or positioners.  

As a consequence, the Online Monitor may show the robot in a non-violating position, even 
though the safety controller has detected a safety violation and stopped the robot. 

FlexPendant Viewer running with automatic reloading 

When having FlexPendant Viewer running with automatic reloading of the screens and at 
the same time jogging the robot with the joystick the robot jogging might halt when the 
FlexPendant Viewer reloads. 

5.2.1 Online - Paint 

Backup for Paint systems does not create backup of the PIB board 

The Backup function of RobotStudio does not create a backup of the PIB board of the 
IRC5P system.  
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Workaround: Create the backup of the PIB board with the FlexPaint Pendant using an 
USB-stick.  

Go Offline does not work for Paint systems 

The Go offline function will not create a working Virtual controller system for Paint system 
unless the Paint package I/O option is set to Simulated. 

5.2.2 Online – Integrated Vision 

Information – Integrated Vision only works on 32-bit installations  

It is not possible to use Integrated Vision in the 64-bit version of RobotStudio. 

Information – Camera firmware version and update  

The minimum firmware version to be used with Integrated Vision is 4.08. If this version is not 
available for a specific camera model, then the newest version available shall be used. 

There are two important things to know before upgrading a sensor 

 The user must make sure to first backup the files on the camera. This can be done 
using the Rapid snippets for camera backup/restore, or the FlexPendant Explorer. 

 The latest available firmware version may vary across sensor types. However, when 
the firmware update utility presents the latest available version it shows the 
firmware with the highest version number which may not apply to the sensor to be 
updated. However, the appropriate firmware will be applied.  

Information – The spreadsheet view 

The spreadsheet view is not enabled when editing in the in the following modes “Add part 
location tool”, “Add part inspection tool”. Before entering the spreadsheet mode click for 
example “Setup Image” or Output to Rapid.  

Information – Calibration board without fiducial  

When using the calibration boards, checkerboard or board with dots, the user must select 
the preferred origin by clicking and accepting (press enter) three points on the board. Only 
after these three points have been selected is it possible to click “calibrate” to execute the 
calibration. 

Information - Use default camera settings 

If the camera is not using default communication settings the result may be that RAPID 
instructions return error code “Communication Error”. The safest method to get default 
settings is to go to Connect->Add Sensor Right click and select “Show all sensors”. Select 
the device to reset and click “Apply factory settings” in the lower right corner. The most 
important settings are: 

 Telnet port: 23 

 User: “admin” 

 Password: “”  

Information – User Credentials 

It is now possible to create user profiles with different access levels on the camera. For 
detailed information about this, please refer to the Integrated Vision User Manual.   
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Remaining error – Save image on camera 

It is not possible to save an image on the camera using “Save Image”. This is by design, but 
the dialog still allows the user to try to do this. The result is that the image is not saved and 
no error message is given. 

Remaining error - Connect button greyed out for no reason 

It may sometimes happen that the “Connect” button is greyed out, with the tooltip saying the 
the camera is not on the correct subnet although the IP settings are OK.  

Workaround: Restart the Integrated Vision Add-In. 

Remaining error – VC started from Controller->Add controller does not detect cameras 

A VC that is started from Controller->Add controller does not detect cameras on the 
network, even if the VC_network_definition.xml is correctly configured and the firewall is 
turned off. The reason is that the controller is not able to detect new cameras on the 
network when it is in “Motors On” state. When the VC is started stand-alone in RobotStudio 
it is automatically set to “Motors On“ when started.  

Workaround: To allow it to discover cameras, turn the control panel key to manual mode or 
launch the VC as part of a station. 

User tip - Removing cameras from configuration 

To remove a configured camera from the list of configured cameras, use the configuration 
editor. Enter Configuration->Communication->Application Protocols and remove the desired 
camera. Perform a warm start to complete the operation.  

User tip – Viewing all cameras present on the network 

Connect->Add Sensor is normally used for setting the IP addresses of sensors that are not 
currently on the correct subnet (192.168.125.X). Since the dialog shows all cameras “seen” 
by the PC, this dialog is useful when error tracing camera network problems.  

If a camera does not appear on the network using the “Add sensor” dialog as suggested 
above, it is advisable to cycle the power of the camera. If the camera receives power from 
the controller, then cycle power by turning the mains switch. 

User tip – Warm start the controller after changing network settings 

Whenever changing the network settings of the camera, either from Connect->Add Sensor 
or Connect->Network settings, it is important to warm start the controller. If this is not done, 
RAPID instructions will give the error “Communication Error” and the FTP-mounted camera 
disk is not accessible. If DHCP addres is used and persits, please try a static address 
instead.  

5.3 Offline 

5.3.1 General 

*The Work Envelope function does not support IRB 14000 

The function is disabled for the IRB 14000 and cannot be activated. 

The 2D work envelope fails for certain robot models 

As a result, the generated work envelop may appear distorted. 

Update of current selection in the 3D graphics window may be delayed 

A problem related to the graphics driver has been observed on certain PCs. The problem is 
that the update of the current selection in the 3D graphics is delayed until the next redraw. 
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Workaround: Add or uncomment the following line in the file RobotStudio.exe.config  

<add key=”DoublePresentWorkaround” value=”true” /> 

Failure to open Pack&Go file to same folder the second time 

RobotStudio will prevent Pack&Go files to be opened to the same folder a second time if the 
station contains VC systems with the EPS or SafeMove option. This is by design to prevent 
the safety controller configuration file to be accidentally overwritten . 

Workaround: Remove the write protection manually using Windows Explorer. 

Updates of instruction template and code snippets 

RobotStudio will not automatically update the user files for instruction templates and code 
snippets files in the folders: 

…\My Documents\RobotStudio\Instruction Templates 

…\My Documents\RobotStudio\Code snippets 

Workaround: The user has to manually copy the latest files from  

%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Instruction 
Templates,  

and 

%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Code 
Snippets  

to the data folder. 

IO signals configured with access level ‘DEFAULT’ 

When IO signals are configured with access level ‘DEFAULT’, only input signals are 
possible to set/reset from the I/O Simulator and I/O Window. To be able to affect also output 
signals, set the access level to ‘ALL’ for them in the Configuration Editor.  

VC does not start with RRI option and GSI folder structure missing. 

The VC will hang when started with a system containing the RobotWare option RRI (Robot 
Reference Interface) if the GSI folder structure is missing.  

Workaround: create GSI Folder before starting the VC inside the HOME directory of the 
system. See the Application Manual for Robot Reference interface for more information. 

System in Guard Stop state in Automatic mode after run-time error 

Certain run-time errors may cause the controller system to enter Guard Stop state in 
Automatic mode. This is the same behavior as in a physical robot controller system. This 
typically happens when a run-time error related to Conveyor Tracking occurs. A simulation 
cannot be started when the controller is in this state.  

Workaround: To reset the controller state, open the Control Panel window and first switch 
to Manual mode, and then back to Automatic mode. 

Information message starting system with IRB260/460/660/760 

Starting a system with IRB260/660 gives you an error message: ‘The number of joints is 
different between the library model and the controller configurations’. The reason is that the 
IRBx60 is modeled with six joints in RobotStudio of which two are locked, but has four joints 
in the VC  
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Path handling of instructions with multiple joint targets 

The path functions Rotate, Translate, and Mirror do not work as expected with instructions 
containing via points as jointtargets. The functions will leave the jointtargets as is. 
Interpolate Path gives an Unknown Error and Tool Compensation reports an error message  

Event Manager: Simulation cannot be triggered by analog system signals  

The event manager only supports analog station signals, not analog system signals  

5.3.2 Station Viewer 

Memory problem when doing Save As Viewer or Record to Viewer with large stations 

RobotStudio may run out of memory (OutOfMemory exception) when doing Save As 
Viewer or Record To Viewer if the station is very large. 

Workaround: Use the 64-bit version of RobotStudio and create a 64-bit viewer by ticking 
the checkbox in the Save As Viewer file dialog. 

5.3.3 MultiMove 

MultiMove error: ‘Object reference not set to an instance of an object’ 

When the Test Play button is pressed in the MultiMove tool, the following error message 
may be displayed: ‘Object reference not set to an instance of an object’, but the robot moves 
and the Status ‘Calculation OK’ is displayed. In addition, when ‘Create Paths‘ is pressed the 
following message is displayed: ‘Can't create paths : Value cannot be null’, and no paths are 
created. In the ‘Create Paths Settings’, is the WP TCP drop down empty. 

Reason: wobj is not set for the current task 

5.3.4 External Axis 

Error 50091: ‘Restart not possible’ after warm start of a system with external axis 

When restarting a system with activated mechanical units the activation state is lost. Then 
the program can no longer be started from the Virtual FlexPendant, the RAPID Editor or the 
RAPID Tasks window. 

Workaround: Reset the program pointer (‘Program Pointer to Main’) before starting the 
program from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window, or, 
start the program from the Simulation Play button.  

5.3.5 Network Drives and UNC Paths 

RobotStudio on computers with roaming user profiles 

RobotStudio may fail on PC configurations with roaming user profiles, i.e. when the users’ 
documents folder resides on a server and not on the local disk. 

Workaround: Redefine the ’User Project Folder’ to a folder on the local disk (File → 
Options → General → Files&Folders → User Project Folder). 

Virtual Controller does not support UNC paths 

UNC paths cannot be used to locate Virtual Controller systems. Using UNC paths for VC 
systems will cause the log message ‘Failed to initialize FW upgrade framework’ to appear 
when the system starts. Subsequent attempts to work with the VC such as synchronizing 
RAPID data will fail. 
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Creating and starting systems located on a network drive 

When using a network drive to store RobotStudio data such as RobotWare systems or the 
RobotWare mediapool, the following problems may occur 

 Virtual controller does not start 

 Not possible to open VirtualFlexpendant  

Cause: By default, the .NET Framework does not allow execution of code from a remote 
file system. This means the application may behave unexpectedly if the media used by the 
system or the system itself resides on a network share. 

Workaround: To resolve this, the user must explicitly grant the required permissions: 

1. Open the file Virtual FlexPendant.exe.config located in  

C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.61\Bin 

2. Add the following lines 

<?xml version="1.0"?> 
<configuration> 

<startup useLegacyV2RuntimeActivationPolicy="true"> 
   <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/></startup> 

<runtime>                <!-- THIS IS ONE OF THE NEW LINES!!! --> 

<loadFromRemoteSources enabled="true"/>  <!-- THIS IS ONE OF THE NEW LINES!!! --> 
</runtime>       <!-- THIS IS ONE OF THE NEW LINES!!! --> 

</configuration> 
 

The Virtual FlexPendant must be restarted for the changes to take effect. 

For further information, see 

http://msdn.microsoft.com/en-us/library/dd409252(v=vs.100).aspx 

 

5.3.6 RAPID  

Robtarget names must be unique in RAPID even if they are LOCAL 

RobotStudio requires that robtarget names are unique for the RAPID synchronization to 
work properly, i.e. you cannot have a global robtarget named pMyTarget1 in module A and 
a local robtarget with the same name in Module B.  

Global robtargets cannot be made local through Synchronization to VC 

Global robtargets cannot be changed to local through Synchronization to VC, the option is 
disabled (PDD 3140). 

Workaround: Change the robtargets to module local in the RAPID Editor and Synchronize 
to station. 

Error Message: Sync. to Station completed with errors 

Error Message: Sync to Station completed with errors: New data <name> <type> has same 
name  as existing object in same block <routine>. 

When this error message appears, there is a storage type mixup between data already 
stored in RS and in the VC. Because of this, and per design, the data is not considered the 
same data.  

    Note 
 
Windows security settings may prevent the file from being directly edited in the default 
location. Copy the file to your local Documents folder to edit it. Upon completion, you 
need to manual copy the file back to its original location. 

http://msdn.microsoft.com/en-us/library/dd409252(v=vs.100).aspx
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Workaround: 1. Ensure all data declarations have the same definition in RS as in RAPID 
(there is no user interface for this). 

2. Sync to station should now work. 

3. Sync back to controller, and remember to change the data declarations back to what you 
want. 

5.3.7 Paint 

Lack of Virtual Controller support for the Paint systems 

Paint systems that are configured using the Paint package I/O option Discrete, Compact or 
Fieldbus, will result in a SysFail state. 

Workaround: Re-create the system with the simulated I/O option. 

Compiling a Conveyor Mechanism does not disable the Compile button 

After compiling a conveyor mechanism, using the Create Mechanism tool, the Compile 
Mechanism button is not disabled. If the user presses the Compile button again, without 
changing anything, another identical conveyor mechanism will be created  

5.3.8 Graphics and Geometry 

Enforce selected graphics device for PCs with multiple graphics cards 

For best performance when running RobotStudio on a PC with multiple graphics cards, 
RobotStudio can be configured to use a specified device. By this option you can ensure 
maximum performance. This is useful for e.g. Lenovo W540 that has both an integrated Intel 
graphics device and a discrete NVIDIA card. 

Open the file RobotStudio.exe.config that is located in the folders 

C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 6.0\Bin64 

and 

C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 6.0\Bin 

and uncomment the line 

<add key="GraphicsDeviceType" value="Discrete"/> 

Valid values are 'Discrete', 'Integrated' and 'Warp' (software renderer). 

Note that there are two different files, one for the 32-bit version, and another for the 64-bit 
version. 

Problems when undoing Boolean operations on Geometry 

Undoing a Boolean operation might not succeed. To recover from these problems, you need 
to delete the items that caused the problem. 

Out of memory 

The application might fail when out of memory due to the import of very large ACIS files or 
load of very large stations.  

Workaround: Use the 64-bit version that can handle more memory. Ensure that you have 
enough memory installed on the PC, see System Requirements. 
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5.4 ScreenMaker Limitations 

*A ScreenMaker application may fail to build if the DPI setting is not set to 100% 

Certain UI controls in ScreenMaker may fail to build correctly if the DPI setting is not set to 
‘Smaller – 100%’.  

Symptom: The error message caused by this problem will read ‘System.Drawing.Font’ 
does not contain a constructor that takes 2 arguments. 

Workaround: Set DPI to 100% on your PC. 

File changes to FlexPendant applications does not load the changes until a FlexPendant reset  

With RobotWare 6.0x the controller's restart will no longer reset the FlexPendant memory. 
This was part of an effort to improve the restart time of the controller.  

This means that after placing a new FlexPendant application file(s) on the FlexPendant unit, 
you need to manually reset the FlexPendant for it to reload its assets. 

To manually reset the FlexPendant you need to use the reset button on the FlexPendant's 
backside. (See Operating Manual – IRC5 with FlexPendant, 3HAC16590)  

Dynamic update of Rapid Data  

The switch from Manual Mode to Auto Mode causes the RAPID boolean data bound to the 
enabled property of control change to value TRUE. This behaviour is noticed when the 
mode is changed from a different screen and not on the screen where the control is bound 
to RAPID boolean data. An additional side effect is that the enabled property of RunRoutine 
button has been disabled  as similar behavior was seen.  

Running Routine with Movement 

RunRoutine Button control does not always work correct when a routine with movements is 
called. 

As a workaround use instructions like StopMove, StorePath, RestorePath and StartMove to 
control the movements of the robot. 

A Trap routine could be called with a normal button control and in the Trap the above 
instructions can be used to control the movements of the robot.  

 

PictureBox control as a Widget 

If a Picture Box control is created as a widget from a Windows 8 operating system, the 
control is not shown on the FlexPendant. The behavior is fine with any other operating 
system like Windows 7. 
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6 RobotWare Compatibility 

6.1 General 

Supported RobotWare versions 

RobotStudio 6.00.01 is distributed with RobotWare 6.00.01 and works with RobotWare 5.07 
and later. Please check details below. 

6.2 RobotWare 5.05 and 5.06 Compatibility 

RobotWare 5.05 and 5.06 including revisions thereof are not supported by RobotStudio 5.15 
and later versions. Please use the corresponding version of RobotStudio for managing robot 
controllers with any of these RobotWare versions. 

6.3 RobotWare 5.07 Compatibility 

RobotWare 5.07 and its revisions of are supported with the following limitations: 

General 

The location of the program pointer is not updated in the RAPID Editor during program 
execution. 

Offline 

A limitation in the versions 5.07.02, 5.07.03, and, 5.07.04 of RobotWare may cause the 
Virtual Controller to System Failure state during I-start on certain computers. The problem is 
due to the ctrl.bin-file not being correctly created. 

Workaround: Create an empty ctrl.bin file in the INTERNAL folder of the controller system, 
and then perform a warm start. 

 

The virtual controller does not support RobotWare 5.07.08 and RobotWare 5.07.07.  

Online 

FlexPendant Viewer does not work RobotWare 5.07 

6.4 RobotWare 5.08 Compatibility 

RobotWare 5.08 and its revisions of are supported with the following limitations: 

Offline 

RobotWare 5.08 is not supported. 
Workaround: Use RobotWare 5.08.01 or later. 

6.5 RobotWare 5.10 Compatibility 

RobotWare 5.10 and its revisions of are supported with the following limitations: 

Offline 

Starting a controller will generate internal UAS error in controller error log. 

6.6 RobotWare 5.11 Compatibility 

RobotWare 5.11 and its revisions of are supported with the following limitations: 

    Note 
 
The problem will reappear if the system is I-started.  
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Offline 

Linear jogging of a robot across joint values that will cause a change of confdata may fail. 
For example, if the robot is jogged linearly when joint values is passing 90 degrees for axis 
1 may cause the robot to stop or to change configuration. 

6.7 RobotWare 5.12 Compatibility 

RobotWare 5.12 and its revisions of are supported with the following limitations: 

Paint backups from RW 5.12.01 not compatible with RW 5.12.02 or later 

Restoring a paint system backup from RobotWare 5.12.01 will cause SysFail for RobotWare 
5.12.02 or later 

Workaround: Add the following parameters to the configuration files 

EIO.CFG: 

EIO_SIGNAL: 

      -Name "doMainInMC" -SignalType "DO" -Unit "SysComm" -UnitMap "44" 

      -Name "A1HVErrNo" -SignalType "GO" -Unit "SysComm" -UnitMap "150-151"\ 

      -Access "ALL" 

      -Name "A1HVEn" -SignalType "DO" -Unit "SysComm" -UnitMap "155"\ 

      -Access "ALL" 

EIO_CROSS: 

      -Res "A1HVEn" -Act1 "HVEnabled" 

SYS.CFG: 

CAB_TASK_MODULES: 

      -File "INTERNAL:/pntrapid/T_ROB1/cycinfo.sys" -ModName "cycinfo"\ 

      -Task "T_ROB1" 

      -File "INTERNAL:/pntrapid/csvlkup.sys" -ModName "csvlkup" -AllTask \ 

      -Hidden 

6.8 RobotWare 5.13 Compatibility 

RobotWare 5.13 and its revisions of are supported with the following limitations: 

Paint backups from RW 5.12.02, 5.12.03 or RW 5.13 or 5.13.01 not compatible with RW 
5.13.02 or RW 5.13.03 

There are several changes in the configuration database for I/O (EIO.CFG) and Controller 
(SYS.CFG) that will cause System Failure if an old backup is loaded. There are also 
changed in installed RAPID modules. To create a compatible configuration, proceed as 
follows: 

1. Create and start a VC with a RobotWare 5.13.03 system containing the same 
options as your original backup, but do not load the backup. 

2. Save the EIO.CFG and SYS.CFG to file. 

3. Compare the saved files with the corresponding files of your backup. (You can 
use a text file comparison tool for simplification.) 

4. Add your system-specific configuration to the general configuration files saved 
from the 5.13.01-system using a text editor. 

5. Replace the files of the original backup with the corresponding modified 
configuration files. 

6. Go through the RAPID modules of the backup and remove the default modules 
(i.e. those that are not changed by the user). 

7. Load the backup and restart the system. You are done. 
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6.9 RobotWare 5.15 Compatibility 

Signal Analyzer Online 

 The feature Signal Analyzer Online requires RobotWare 5.15.03 or later. 

6.10 RobotWare 6 Compatibility 

Overview 

RobotWare 6.00 and 6.00.01 systems cannot be directly upgraded to RobotWare 6.01. To 
upgrade a system, you need to create backup and migrate it using the tool ‘Migrate Backup 
or Folder’, then recreate the system and finally, restore the backup. 

For this reason, the functions ‘Unpack&Work’, ‘Go Offline’ and ‘New Solution with Station 
and Robot Controller – From backup’ are blocked to prevent upgrade from RobotWare 6.00 
or 6.00.01 to RobotWare 6.01. 

RobotStudio, however, is compatible with both RobotWare 6.00 / 6.00.01 and 6.01. 

6.11 General Compatibility Limitations 

RAPID Profiler 

The profiler will be able to create a log file for the profiler automatically for RobotWare 5.14 
or later. For RobotWare 5.13 or earlier, the log file must be created manually using the 
RAPID Spy command (SpyStart/SpyStop). 

Safety Configuration 

Safety configuration of a track motion IRC5 system equipped with a safety controller of type 
EPS or SafeMove can be done without the need to read track motion parameters manually 
when using RobotWare 5.11.01 or later. Encrypted parameters needed by the safety 
controller will be automatically read by EPS Wizard and SafeMove Configurator, 
respectively. 

Signal Analyzer Online 

Signal Analyzer Online requires RobotWare 5.15.01 or later. 

Signal Analyzer. 

The error message Failed to subscribe on signal may sometimes appear during signal 
recording for RobotWare 5.15 or earlier. 

Workaround: Restart the VC or upgrade to RobotWare 5.15.01 or later. 

Configurations 

The feature Configurations for selecting the robot arm configuration (confdata) may fail, 

or not present all solutions, in some specific circumstances even when the target is 
reachable if RobotWare 5.14 or earlier is used. 

Workaround: Upgrade to RW5.14.01 or later 

6.12 ScreenMaker Compatibility 

RobotWare 

It is possible to use previous RobotWare versions, but with some limitations.  

 ActionTrigger will work only on RobotWare 5.12.02 or later. 
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 The controls Button, TpsLabel and PictureBox controls was modified in 
RobotStudio 5.13. The property ‘Allow MultipleStates’ of these controls can be 
accessed from RobotWare 5.13 and later. 

 Variant Button will work only on RobotWare 5.14.01 or later 

 Conditional Trigger will work only on RobotWare 5.14.01 or later 

 Widgets will work only on RobotWare 5.60 or later. 

FlexPendant SDK 

ScreenMaker should be used with FlexPendant SDK 5.12.02 or later. ScreenMaker allows 
selection of FlexPendant SDK version when it is launched. If only one version of 
FlexPendant SDK is available in the system, it is loaded by default. 

 

6.13 Support for future RobotWare versions 

RobotStudio 6.01 supports all future minor revisions of RobotWare 6.01, but no future major 
releases. For example, RobotStudio 6.01 will support RobotWare 6.01.01 (if, and when 
available) but not RobotWare 6.02, or 6.03. 

 


